Contents

HOW DO I LOGIN TO 123-MAIL WEBMAIL?  4

THE START PAGE INTERFACE  5
Elements of the start page  5
The toolbar explained  6
The start page panel explained  6
The overview window explained  6
Hovers feature explained  7

E-MAIL SECTION  8
The E-mail interface explained  8
The E-Mail panel explained  8
The E-Mail overview window explained  8
Displaying E-Mails  9
How do I change the way E-mails are displayed?  9
How do I Send a new E-Mail message?  9
How do I add attachments to my E-mails?  11
How do I reply to E-Mails?  12
How do I forward E-Mail messages?  13

CONTACTS SECTION  14
The Contacts panel explained  14
The contacts overview window  14
Viewing contacts  14
How do I change the way contacts are displayed?  15
How do I create new contacts?  15
Searching for contacts  17
How do I search for a contact?  
How do I display all my contacts from the current contact folder?  
How do I edit a contact?  
How do I send a contact as a vCard attachment?  

**CALENDAR SECTION**  
The calendar panel  
The calendar overview window  
Viewing the calendar and appointments  
How do I display a calendar and its appointments?  
How do I Create an appointment?  
How do I edit an appointment?  
How do I edit an appointment title?  
How do I drag an appointment to another day?  
How do I change the time of an appointment?  
How do I change the start or end date of an appointment?  

**TASKS SECTION**  
The tasks panel explained  
The tasks overview explained  
Viewing tasks  
How do I display tasks?  
How do I create new tasks?
How do I login to 123-Mail webmail?

To login to your 123-Mail powered webmail, please follow the below instructions:

1. Go to https://webmail.123-reg.co.uk/
2. Enter your Email address and password.
3. Click on the Login button.
The start page interface

Directly after you login the start page is displayed as follows.

Elements of the start page

The start page contains the following elements:

<table>
<thead>
<tr>
<th>No.</th>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Toolbar</td>
<td>Contains from the left to the right:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Icons for accessing the different sections.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Button for accessing the help, button for refreshing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Search input field</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Logout button</td>
</tr>
<tr>
<td>2</td>
<td>Collapse icon</td>
<td>Expands or collapses the side bar.</td>
</tr>
<tr>
<td>3</td>
<td>Panel</td>
<td>Contains the functions that are available on the start page.</td>
</tr>
<tr>
<td>4</td>
<td>Side bar</td>
<td>Contains the following elements:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The folder tree. It shows the folder structure of the groupware Objects*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The space used and available in the current module. Depending on the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>folder tree displayed, the information is completely or partly hidden.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The mini calendar. It displays the current date. Allows you to access</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the calendar module.</td>
</tr>
<tr>
<td>5</td>
<td>Overview window</td>
<td>Shows module windows with current objects. Each module window has its</td>
</tr>
<tr>
<td></td>
<td></td>
<td>own title bar. The display in the overview window can be configured.</td>
</tr>
<tr>
<td>6</td>
<td>Window separator</td>
<td>Changes the width of the side bar.</td>
</tr>
</tbody>
</table>
The toolbar explained

The toolbar contains the following elements:

<table>
<thead>
<tr>
<th>No.</th>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start page icon</td>
<td>Switches to the start page.</td>
</tr>
<tr>
<td></td>
<td>E-Mail icon</td>
<td>Switches to the E-Mail module.</td>
</tr>
<tr>
<td></td>
<td>Calendar icons</td>
<td>Switches to the calendar module.</td>
</tr>
<tr>
<td></td>
<td>Contacts icon</td>
<td>Switches to the contacts module.</td>
</tr>
<tr>
<td></td>
<td>Tasks icon</td>
<td>Switches to the tasks module.</td>
</tr>
<tr>
<td></td>
<td>InfoStore icon</td>
<td>Switches to the InfoStore module. (professional mailboxes only)</td>
</tr>
<tr>
<td></td>
<td>Options icon</td>
<td>Switches to the options module.</td>
</tr>
<tr>
<td></td>
<td>Expert mode checkbox</td>
<td>Activates or deactivates the complete folder tree.</td>
</tr>
<tr>
<td>2</td>
<td>Help icon</td>
<td>Opens the online help, the most recent error messages, and information about the groupware version number.</td>
</tr>
<tr>
<td>3</td>
<td>Refresh icon</td>
<td>Click this button to retrieve new objects from the server. Objects are automatically refreshed infrequent intervals regardless of clicking this button. An animated icon on the button displays this process.</td>
</tr>
<tr>
<td>4</td>
<td>Logout button</td>
<td>To finish working with the groupware click this button.</td>
</tr>
</tbody>
</table>

The start page panel explained

The start page panel contains the following elements:

<table>
<thead>
<tr>
<th>No.</th>
<th>Panel section, icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>New</td>
<td>Creates new object</td>
</tr>
<tr>
<td>2</td>
<td>Synchronisation</td>
<td>Installing the OXtender for Microsoft Outlook, configuring the mobile phone*</td>
</tr>
<tr>
<td>3</td>
<td>Collapse icon</td>
<td>Expand or collapse the panel</td>
</tr>
</tbody>
</table>

The overview window explained

The overview window of the start page contains several section windows displaying different entries. The following section windows are displayed by default:

<table>
<thead>
<tr>
<th>Section window</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail</td>
<td>Shows the current unread E-Mail. The sender, subject, date and time of the receipt are shown.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Displays your current appointments. Shows appointments taking Place today, the next two days, next week or later. For each appointment the date, time and description is displayed.</td>
</tr>
<tr>
<td>Tasks</td>
<td>Displays your current tasks. Shows tasks taking place today, the next two days, next week or later. For each task the subject, date and priority is displayed.</td>
</tr>
</tbody>
</table>
Hovers feature explained

When hovering over certain elements, detailed information about the object below will be shown in a hover pane.

1. Move the mouse pointer over an object in the overview window. After a short delay the hover pane opens. It displays the General tab and details relating to the item you hover over.

2. To view further information you can click on the other available tabs.

3. To close the hover mode, move the mouse pointer away from the object.
E-Mail section

The E-mail interface explained

Click on the E-mail icon in the toolbar to open the Email interface.

The E-Mail panel explained

The E-Mail panel includes the following functions in different panel tabs:

<table>
<thead>
<tr>
<th>Panel tab</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create new E-Mail messages or other objects</td>
</tr>
<tr>
<td>Edit</td>
<td>Send, reply, forward, delete, print, and manage E-Mail messages</td>
</tr>
<tr>
<td>Attachments</td>
<td>Open and save E-Mail attachments</td>
</tr>
<tr>
<td>View</td>
<td>Set the E-Mail view: H Split, V Split, List</td>
</tr>
</tbody>
</table>

Please Note: You need to click on an email that contains an attachment to activate the panel section functions.

The E-Mail overview window explained

The E-Mail overview window, H Split view:

The E-Mail overview window contains the following elements:

<table>
<thead>
<tr>
<th>No.</th>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Label</td>
<td>Displays the name and path of the current E-Mail folder, the number of unread E-Mail messages, and the number of E-Mail messages in this folder. <strong>Tip:</strong> You can browse the folder tree by clicking the underlined parts of the path.</td>
</tr>
<tr>
<td>2</td>
<td>Options button</td>
<td>Opens the E-Mail settings.</td>
</tr>
<tr>
<td>3</td>
<td>Content area</td>
<td>Displays the E-Mail messages in the current E-Mail folder.</td>
</tr>
</tbody>
</table>
Displaying E-Mails

The following views are available:

- The List view. It displays the E-Mail messages in an E-Mail folder in the form of a table. You can sort the table by clicking a column title.

- The H-Split view. In the upper part of the overview window it displays the E-Mail list view and in the lower part it displays the content of the selected E-Mail.

- The V-Split view. In the left part of the overview window it displays the E-Mail list view and in the right part it displays the content of the selected E-Mail.

How do I change the way E-mails are displayed?

To change the way E-mails are displayed, please follow the below instructions:

1. Select an E-Mail folder in the folder tree. e.g. **Inbox**

2. Click on the View menu.

3. In the View panel tab click **H-Split**, **V-Split** or **List** view.

4. If you selected **H-Split** or **V-Split** select an E-Mail in the list view.

How do I Send a new E-Mail message?

To send a new E-mail message, please follow the below instructions:

1. In the New panel tab click the New E-Mail icon. The E-Mail window will open.
2. Select a sender address from the drop down.

3. Select one or more recipients.

4. Enter a subject.

5. Compose the E-Mail text.

6. Use additional options if needed:
   - Add attachments.
   - Attach your vCard.
   - Enter a specific sender.
   - Set the priority.
   - Request a delivery receipt.

7. Click on the Send icon in the panel. The window will close.

The E-Mail will now be sent. A copy of the E-Mail is saved in the Sent Items folder.
How do I add attachments to my E-mails?

To add attachments to your E-mail messages, please follow the below instructions:

1. Click on Add attachment icon within the sending email panel, Then click on the Attach local file from the drop down. The Select attachments dialog window will open.

2. In the Select attachments dialog window click on the Browse button. Select the file to be added as an attachment.

3. Click on the OK button.

4. To add further attachments repeat steps 1-3.

5. To remove an attachment, select it in the list field at the bottom of the window.

6. Then click on the Remove attachment icon.

The filenames of the attachments are displayed below the E-Mail text.
How do I reply to E-Mails?

To reply to an E-mail message, please follow the below instructions:

1. Select an E-Mail in the H Split, V Split, or List view.

<table>
<thead>
<tr>
<th>From</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 Anthony</td>
<td>Example - Email</td>
</tr>
</tbody>
</table>

2. In the Edit tab click on the Reply icon.

To also reply to the recipients in CC click on the Reply all icon. The E-Mail window will open.

3. Enter the E-Mail text.

4. Click on Send in the panel. The window will be closed.

The E-Mail will now be sent. A copy of the E-Mail is saved in the Sent Items folder.
How do I forward E-Mail messages?

To forward an E-mail message, please follow the below instructions:

1. Select an E-Mail in the **H Split, V Split, or List view**.

2. Click on Forward icon in the Edit panel tab. The E-Mail window will open.

3. Select one or more recipients.

4. Enter the E-Mail text.

5. Click on **Send** icon in the panel. The window will close.

The E-Mail will now be sent. A copy of the E-Mail is saved in the **Sent Items** folder.
The Contacts panel contains the following functions in several panel tabs:

<table>
<thead>
<tr>
<th>Panel tab</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create new contacts or other objects</td>
</tr>
<tr>
<td>Edit</td>
<td>Create, edit, delete, print, and manage contacts</td>
</tr>
<tr>
<td>Send</td>
<td>Send contacts as an E-Mail's vCard attachment</td>
</tr>
<tr>
<td>View</td>
<td>Set the display of contacts: address cards, phone list, and detail</td>
</tr>
<tr>
<td>Flag</td>
<td>Mark contacts with flags</td>
</tr>
</tbody>
</table>

The contacts overview window

The contacts overview window, Phone list view:

The contacts overview window contains the following elements:

<table>
<thead>
<tr>
<th>No.</th>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Labelling</td>
<td>Displays the name and path of the current contacts folder and the number of contacts in this folder. Tip: You can browse the folder tree by clicking the underlined parts of the path.</td>
</tr>
<tr>
<td>2</td>
<td>Options button</td>
<td>Opens the contacts settings.</td>
</tr>
<tr>
<td>3</td>
<td>Content area</td>
<td>Displays the contacts.</td>
</tr>
<tr>
<td>4</td>
<td>Quick filterbar</td>
<td>Allows you to filter the displayed contacts via the first letter of the contacts' last names.</td>
</tr>
</tbody>
</table>

Viewing contacts

The following views are available:

- The phone list. The contacts are displayed in the form of a table. You can sort the table by clicking a column header.
- The address card view. The contacts of the current contact folder are displayed as address cards.
- The detail view. All information for the contact selected in the phone list or address card view is displayed.
How do I change the way contacts are displayed?

To change the way your contacts are displayed, please follow the below instructions:

1. Select a contact folder in the folder tree.

2. In the View tab click on the view you would like to change to. e.g. Phone list

How do I create new contacts?

To create a new contact, please follow the below instructions:

1. In the New tab click on the New Contact icon.

The Contact window will open. The Business tab is opened.

2. If required select a contact folder by clicking the Folder… button and selecting a contact folder in the pop-up window.

3. Enter the business data for the contact in the Business tab.
4. You can also add the contact to a category by clicking on the Categories… button if needed.

5. You can also set a contact as private by checking the tick box next to Private contact.

![Categories]

Please Note: You can only mark a contact as private if you create the contact in a personal contact folder.

6. You can enter private data for the contact in the Private tab.

![Private tab]

7. You can create an appointment series for the contact's date of birth by clicking on the + calendar icon next to the Date of birth section. This will remind you of the contact's birthday.

![Date of birth]

8. You can add a picture for your contact by clicking on the picture and selecting an image from your computer's local files.

![Add picture]

9. In the Additional tab you can enter further data for your contact.

![Additional tab]

10. Click on the Save icon to save the new contact.
Searching for contacts

You can find contacts in the current contacts folder via a search term. The search term defines the character string to be searched for.

The following contact data can be used as a search term:

- First name, surname, displayed name
- E-Mail (business), E-Mail (private), E-Mail (other)
- Company, department
- Location, Street
- Tags

How do I search for a contact?

To search for a contact, please follow the below instructions:

1. In the search field on the Contacts pane, select the search criteria by clicking on the arrow and ticking the relevant tick boxes.

2. Enter the search term and click on the Search icon.

Your search results will be displayed below matching the search term entered.

How do I display all my contacts from the current contact folder?

In the Search input field click the Clear(X) icon.
How do I edit a contact?

To edit a contact, please follow the below instructions:

1. On the **Contacts** section, click on the contact you wish to edit.

2. In the **Edit** tab click on the **Edit** icon. The Contact window will open.

3. Edit the contact’s data and click on the **Save** icon. Your contact will now be updated.

How do I send a contact as a vCard attachment?

To send a contact’s details as a vCard attachment, please follow the below instructions:

1. On the Contacts section, click on the contact you would like to use as the attached vCard.

2. In the **Edit** tab click on the **Send as vCard** icon.

The E-Mail window will open with a vCard attached for each selected contact.

3. Complete your email and click on the **Send** icon.

Your E-Mail will now be sent with the vCard attachment(s).
Calendar Section

The calendar panel

The calendar module contains the following functions in different panel tabs:

<table>
<thead>
<tr>
<th>Panel tab</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create new appointments or other objects.</td>
</tr>
<tr>
<td>Edit</td>
<td>Create, edit, delete, print, and manage appointments, change confirmation.</td>
</tr>
<tr>
<td>View</td>
<td>Set an appointment view: Calendar or Team, List. Set a time range for the calendar display: Day, Work week, Week, Month, or Custom.</td>
</tr>
<tr>
<td>Flag</td>
<td>Mark appointments with flags</td>
</tr>
</tbody>
</table>

The calendar overview window

The calendar overview window, Calendar view, Week time range:

The calendar overview window contains the following elements:

<table>
<thead>
<tr>
<th>No.</th>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Labelling</td>
<td>Displays the name and the path of the current calendar folder and the number of appointments in this folder. Tip: You can browse the folder tree by clicking the underlined parts of the path. Note: Labelling is not shown in the team view.</td>
</tr>
<tr>
<td>2</td>
<td>Date bar</td>
<td>Displays the date of the current time range. On both sides of the date there are navigation arrows that allow you to change the current time range.</td>
</tr>
<tr>
<td>3</td>
<td>Today button</td>
<td>Displays the time range containing the current date in the overview Window and in the MiniCalendar. The selected view, Calendar, Team, or List remains in the overview window.</td>
</tr>
<tr>
<td>4</td>
<td>Options button</td>
<td>Opens the calendar settings.</td>
</tr>
<tr>
<td>5</td>
<td>Content area</td>
<td>Displays the calendar and the appointments.</td>
</tr>
<tr>
<td>6</td>
<td>Show all my appointments</td>
<td>If this checkbox is activated all your appointments from all calendar from all calendars check- folders are displayed. If this checkbox is deactivated only your appointments from the current calendar folder are displayed.</td>
</tr>
</tbody>
</table>
Viewing the calendar and appointments

The following views are available:

- The Calendar view. This view displays a calendar sheet comprising a particular time range such as Day, Week, or Month. An appointment is displayed in the form of a rectangle.
- The Team view. This view shows the appointments for users and groups and the resources booked for the individual appointments. A user can create teams. They will remain after the logout.
- The List view. This view shows the appointments for a specific time range in a table form.
- The Detail view. This view shows all information for the appointment selected in the Calendar or List view.

How do I display a calendar and its appointments?

To display a calendar and its appointments, please follow the below instructions:

1. Select a calendar folder in the folder tree.

![Calendar view](image)

2. In the View tab click on the Calendar or List icon.

3. You can also select a time range to view.

![View tab](image)

To view all the details of an appointment do the following:

1. Select an appointment.

![Example app](image)

2. In the View tab click on the Detail icon.

![Detail view](image)
How do I Create an appointment?

To create an appointment, please follow the below instructions:

1. In the **New** tab click on the **New Appointment** icon. The Appointment window will open.

![Appointment window](image)

2. Enter a description, a location, and a comment for the appointment.

3. Select a start and end date for the appointment.

4. Set the appointment reminder.

5. Select the availability view: Booked, Tentative, Absent on business, or Free.

6. Use additional options if needed.
   - Create an appointment series. Add categories to the appointment.
   - If required mark the appointment as private.
   - Add further participants and resources to the appointment. Check whether the participants and resources are available for the appointment.

7. Click **Save** icon in the appointment panel.

![Appointment panel](image)

Your appointment has now been created.
How do I edit an appointment?

To edit an appointment, please follow the below instructions:

1. Click on the appointment in your chosen view.

2. In the **Edit** tab click on the **Edit** icon. The Appointment window will open.

3. Edit your appointment details.

4. Click on the **Save** in the panel. Your appointment will now be amended.

How do I edit an appointment title?

To edit an appointment title, please follow the below instructions:

1. Select an appointment in the calendar view.

2. Click on the appointment title.

3. Edit the title.

4. Press Enter.

How do I drag an appointment to another day?

To drag an appointment to another day, please follow the below instructions:

1. In the calendar view move the mouse pointer over the rectangle displaying the appointment. The mouse pointer changes to a hand icon.

2. Drag the appointment to another day in the time range or to a day in the MiniCalendar.

Your appointment will now be moved to the selected day.
How do I change the time of an appointment?

To change the time of an appointment, please follow the below instructions:

1. In the calendar view the mouse pointer over the rectangle displaying the appointment. The mouse pointer changes to a hand icon.

2. Drag the appointment to another time in the time range.

Your appointment time is now changed.

How do I change the start or end date of an appointment?

To create the start or end date of an appointment, please follow the below instructions:

1. Display an appointment in the Work week or Custom calendar view.

2. Move the mouse pointer to the upper or lower border of the rectangle displaying the appointment. The mouse pointer changes to a double-arrow.

3. Drag the border up or down to another time in the time range.

Your start or end of the appointment will now be changed.
The tasks panel contains the following functions in different panel tabs:

<table>
<thead>
<tr>
<th>Panel tab</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create new tasks or other objects</td>
</tr>
<tr>
<td>Edit</td>
<td>Create, edit, delete, print, and manage tasks</td>
</tr>
<tr>
<td>View</td>
<td>Set the display of tasks: H Split, List</td>
</tr>
<tr>
<td>Flag</td>
<td>Mark tasks with flags</td>
</tr>
</tbody>
</table>

The tasks overview window, List view:

The tasks overview window contains the following elements:

<table>
<thead>
<tr>
<th>No.</th>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Labelling</td>
<td>Displays the name and the path of the current calendar folder and the number of appointments in this folder. Tip: You can browse the folder tree by clicking the underlined parts of the path. Note: Labelling is not shown in the team view.</td>
</tr>
<tr>
<td>2</td>
<td>Options button</td>
<td>Changes to the tasks settings.</td>
</tr>
<tr>
<td>3</td>
<td>Content area</td>
<td>Displays the tasks.</td>
</tr>
</tbody>
</table>

Viewing tasks

The following views are available:

- The H Split view. This displays the tasks list view in the upper part of the overview window and the details of the selected task in the lower part of the overview window.
- The List view. This displays the tasks in the form of a table.
How do I display tasks?

To display tasks, please follow the below instructions:

1. Select a tasks folder in the folder tree.

2. In the View panel tab click **H-Split** or List.

3. If you selected **H-Split** select a task in the list view.

   The content of the selected task is displayed in different tabs.

How do I create new tasks?

To create a new task, please follow the below instructions:

1. In the **New** tab click the **Task** icon.

2. If requested select a tasks folder by clicking the **Folder…** button and selecting a tasks folder in the pop-up window.

3. Enter a subject and notes for the task.

4. Set the priority of the task.

5. Set the due date and the start date.

6. Set the task reminder.

7. If requested use additional options:
   - Mark the task as private. Create a task series.
   - Add categories to the task. Set the details for the task.
   - Add further participants to the task. Add attachments to the task.
8. Click **Save** icon in the panel.

The task will now be created. The editing status is set to Not started or 0 % finished.